
  
   
       
 
 
 

 

 

 

  

   Page 1 of 74 

 

LUXENDO InVi-SPIM 

USER MANUAL 

 

 

 

 



  
   
       
 
 
 

 

 

 

  

   Page 2 of 74 

 

Contents 
 

1. Hardware Overview ......................................................................................................................................... 6 

Sample holder classic ........................................................................................................................................ 11 

TruLive3D Dishes ............................................................................................................................................... 12 

1.1. Additional Options ................................................................................................................................. 14 

1.1.1. InVi SPIM Photomanipulation Module, Future Upgrade Available ................................................ 14 

1.1.2. Lux DATA Image Processing Unit, Future Upgrade Available ......................................................... 14 

2. System Startup............................................................................................................................................... 16 

2.1. Power on the system .............................................................................................................................. 16 

3. Lux Control Overview .................................................................................................................................... 17 

3.1 Abbreviations ......................................................................................................................................... 17 

3.2 Software ................................................................................................................................................. 18 

4. Microscope alignment ................................................................................................................................... 33 

4.1 Alignment ............................................................................................................................................... 33 

4.2 Coarse alignment ................................................................................................................................... 33 

4.3 Fine alignment ........................................................................................................................................ 34 

4.4 Ultra alignment ...................................................................................................................................... 35 

4.5 General topics about alignment ............................................................................................................. 35 

5. Sample preparation ....................................................................................................................................... 37 

6. Image acquisition ........................................................................................................................................... 39 

7. Data Review ................................................................................................................................................... 40 

7.1. Luxendo InVi SPIM File Naming Conventions ........................................................................................ 40 

7.1.1. Folder Hierarchy .............................................................................................................................. 40 



  
   
       
 
 
 

 

 

 

  

   Page 3 of 74 

 

7.1.2. Image Data ...................................................................................................................................... 41 

7.1.3. Meta Data ....................................................................................................................................... 41 

7.2. Viewing InVi SPIM Data in FIJI ................................................................................................................ 42 

7.2.1. Downloading and Configuring FIJI .................................................................................................. 42 

7.2.2. Opening Single Cam_(Long or Short)_00000.h5 Files .................................................................... 43 

7.2.3. Streaming Time Series with the Big Data Processor ....................................................................... 44 

7.2.4. Opening Data Collected in Repetition Mode .................................................................................. 46 

7.2.5. Opening Data Processed with the Luxendo Image Processing Pipeline ......................................... 49 

7.3. Opening InVi SPIM Imaging Data in Arivis Vision4D and Imaris ............................................................ 52 

7.4. Luxendo Image Processor ...................................................................................................................... 53 

7.4.1. Tasks ................................................................................................................................................ 54 

7.4.2. Usage Level ..................................................................................................................................... 55 

7.4.3. Typical Workflow ............................................................................................................................ 56 

7.4.4. Registration (content-based) .......................................................................................................... 57 

7.4.5. Fusion .............................................................................................................................................. 59 

7.4.6. Stitching .......................................................................................................................................... 60 

7.4.7. Output ............................................................................................................................................. 63 

7.4.8. Advanced topics .............................................................................................................................. 63 

7.4.9. Troubleshooting / FAQ / known issues ........................................................................................... 64 

8. Cleaning, Maintenance and Service .............................................................................................................. 66 

8.1. Maintenance by manufacturer .............................................................................................................. 66 

8.2. Exchange of fuses and electric connections .......................................................................................... 66 

8.3. Maintenance by the customer ............................................................................................................... 67 

9. Dimensions .................................................................................................................................................... 69 



  
   
       
 
 
 

 

 

 

  

   Page 4 of 74 

 

10. Environment............................................................................................................................................... 69 

11. Power supply configuration ....................................................................................................................... 69 

12. Setting up the Luxendo InVi SPIM.............................................................................................................. 71 

13. Warning labels ........................................................................................................................................... 72 

14. General information on handling laser components and illumination elements ..................................... 74 

 

 

 

  



  
   
       
 
 
 

 

 

 

  

   Page 5 of 74 

 

Knowledge of this manual is mandatory for the operation of the instrument. It is thus crucial to make yourself 

familiar with the contents of this manual. Please pay special attention to the hints concerning the safe operation 

of the instrument.  

The specifications are subject to change; the hard copy of the manual, however, does not follow any update 

services. 

©  The reproduction, distribution, and utilization of this document as well as the communication of its 

contents to others without express authorization is strictly prohibited. Offenders will be held liable for the 

payment of damages. All rights reserved in the event of the grant of a patent, utility model or design. 
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1. Hardware Overview 

 

The InVi SPIM was original designed with the ideal geometry to image small, delicate samples as e.g. single 

cells, spheroids and organoids with high magnification and resolution. Luxendo InVi SPIM Light-Sheet 

technology is the gentlest way to observe living samples over everything from fast short periods to longer time 

periods lasting several days. Luxendo Light-Sheet Microscopy systems enable high-resolution including 

simultaneous dual channel imaging of delicate samples in their native, stable controlled 3D environment. 

This inverted geometry allows the InVi SPIM to image long-term 3D incubated samples at high speeds, while 

minimizing the effects of photobleaching and phototoxicity.  

The InVi SPIM contains a set of internal X, Y, and Z stages that hold living samples in a distinct sample holder 

with incredibly high mechanical stability, allowing for maximized acquisition speed and high precision of data 

acquisition.  

The InVi SPIM’s light-sheet is created by rapidly sweeping a Gaussian beam through the focal plane. The light-

sheet forming optics in the illumination pathway allow the users to optimize the beam’s length and diameter 

for an individual sample. Homogeneous illumination of the field of view can be achieved by adjusting the light-

sheet thickness and the magnification of the detection optics. About half the field of view can be illuminated 

with a 2µm thick light-sheet at 31.3x.  The laser light used to create the beam is supplied by the InVi SPIM’s 

expandable, alignment-free light source and allows for a range of up to six lasers (405, 445, 488, 515, 532, 561, 

594, 642, and 685).  

Live sample detection optics include one 25x NA 1.1 water immersion objective lens.  The two detection paths 

are each equipped with ten position high-speed filter wheels, allowing users to collect multiple spectral 

channels sequentially or dual channel acquisition simultaneously using the motorized dichroic switch carrying 

three positions.  Filter selection includes both long pass filter to maximize photon efficiently and band pass 

filter that minimize bleed through during multi-channel experiments.  The detection paths also include a two-

position magnification changer that can adjust the overall magnification of the 25x NA 1.1 objectives from 

31.3x to 62.5x with a click of the mouse. The included sCMOS Orca Flash 4.0 V3 cameras from Hamamatsu are 

well-suited for experiments that require high detection efficiency, quantification, and speed. 
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The Inverted View Single Plane Illumination Microscope (InVi SPIM), including its original accessories and 

compatible accessories from other manufacturers, may only be used for microscopy methods, the intended use. 

Light-sheet fluorescence microscopes (LSFM) are designed for fast and gentle acquisition of multi-dimensional, 

high-resolution images of living or non-living specimens. Therefore, the temperature-controlled sample 

chamber is filled with medium adapted to the objective lenses used and the sample carrier is filled with sample 

medium. The sample is inserted into the small volume of the sample carrier inside the sample chamber. The 

sample carrier is connected to a holder that can be moved in three dimensions. The sample is illuminated by a 

light-sheet generated by laser light. The light-sheet is positioned in the focal plane of a detection objective lens, 

whose optical axis is arranged perpendicularly to the plane of the light sheet. Hence, only light from the focal 

plane is registered by the system and used for image formation. 

 

The manufacturer assumes no liability for any malfunction or damage caused by any non-intended use of the 

InVi SPIM system as a whole or any of its components or resulting from any repair or other maintenance 

services carried or tried out by any non-authorized personnel.  Any such activity will void the warranty for the 

whole system including parts not directly affected. This includes any modification of the system computer 

(PC), for example equipment with new hardware or software components by the user. Every manipulation 

voids the warranty of the laser safety. 

  

Furthermore, to guarantee your own safety you are strongly advised to read the manuals, in particular the safety 

instructions, of any modules and additional components of the InVi SPIM system as not all features might be 

listed here explicitly.  

 

The lasers built into the InVi SPIM microscope are classified as laser safety class 3B. The safety 

interlocks ensure that the user is not exposed to dangerous laser radiation. The InVi SPIM itself is a 

laser safety class 1 product. 
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The operator of the system must comply with all applicable accident prevention regulations 

enforced by law.  
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The Luxendo InVi SPIM system complies with the following standards: 

 

EN 61000-6-3:2007 + A1:2011 

IEC 61000-6-3:2006 + A1:2010 

EN61000-6-2:2005 

IEC 61000-6-2:2005 

DIN EN 60825-1:2008 

DIN EN 50581: 2013 
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Sample holder classic 

 

The sample holder classic consists of two parts, the sample carrier (Figure 1 / 2) and a mounting adapter (Figure 

13 / 1) connecting the sample carrier with the translation stages. 

 

Figure 1: Exploded assembly drawing of sample holder 

In order to clean/change the sample carrier, open the lid of the sample chamber. To remove the sample holder, 

loosen the setscrew (Figure 3 / 4) in the mounting adapter and pull the holder off the metal rod. The mounting 

adapter can be detached from the sample carrier by removing the two screws (Figure 3 / 3). 

To reattach the sample holder onto the microscope, first connect the mounting adapter to the sample carrier, 

and then put the assembled sample holder on the metal rod. The setscrew orients the sample holder, ensuring 

a proper angle between the objectives and the sample holder. 
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TruLive3D Dishes 

 
 The TruLive3D Dishes are ready-to-use sample holders for the Luxendo InVi SPIM, InVi SPIM Lattice Pro and the 

TruLive3D Imager light-sheet microscopes. The TruLive3D Dishes have been sterilized and are shipped in sealed 

sleeves. To retain sterile conditions, open the packaging sleeve only under a cell 

culture hood. 

Similar to the classic sample holder, the FEP foil lining the holder serves the dual 

function of a “curved coverglass” and a physical barrier between the immersion 

medium and sample medium. 

The new ready-to-use TruLive3D Dishes are fully compatible with the InVi SPIM. 

The possibility to enable the parallel imaging of samples grown under different 

media conditions. 

Sample preparation:  
1. Remove the dish from packaging and place it in the specialized culture 
stand.  
 
2. Carefully functionalize the TruLive3D Dish with cold plasma (PiezoBrush) for 
30 seconds per well. For optimal ion transfer to the FEP foil, a metal working 
area of a culture hood below the dish is essential. It functions as a counter 
electrode.  
 
3. Subsequently, apply your sample to the dish.  
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Glass slide holders 

 

For live cell samples, customized glass slide sample holders can be used for the convenience of sample 

preparation and cell adhesion. Cells should be seeded on the 3mm x20 mm glass slide with normal cell 

preparation protocols. During imaging, glass slide surface with cells seeded should be facing downwards, such 

that both illumination and detection light path do not need to pass through glass slide, which has a large 

Refractive Index difference with water. 

The cross section view of the objective lenses and glass slide sample holders is shown below: 
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1.1. Additional Options 

 

1.1.1. InVi SPIM Photomanipulation Module, Future Upgrade Available 

The InVi SPIM photomanipulation beam is coupled to the 25x NA 1.1 detection objective lens, to create a 

diffraction-limited illumination spot at the focal plane of the detection objective. A 2D scanner allows the user 

to freely position the illumination spot in all spatial dimensions of the sample while it is being imaged; this 

feature is fully integrated in the acquisition software. Complex illumination regions (point, square, straight and 

freeform line) can be configured as part of the experimental workflow or “on the fly” while a 3D imaging 

experiment is performed. A pulsed laser can be use for ablation experiments while visible lasers can be used 

for other photomanipulation experiments like FRAP, photo-conversion and uncaging.  

The InVi SPIM has the only commercially available light-sheet system that uses a detection objective to deliver 

the photomanipulation beam, allowing the user to draw photomanipulation regions directly on images 

collected by the detection objective.  In contrast, other light-sheet systems utilize extra, long working distance, 

low NA objectives opposite the light-sheet objectives to deliver the photomanipulation light. This 

configuration makes it impossible photomanipulate and image the same regions in scattering samples. 

1.1.2. Lux DATA Image Processing Unit, Future Upgrade Available  

Cutting-edge biological imaging like light-sheet, super-resolution, or multiphoton microscopy, produces a vast 

amount of data; however, storage, transfer, and processing of the generated data remains a challenge. With 

the InVi SPIM, data can be transferred to the Lux DATA processing system by two 10 Gbit/s LAN connections. 

There, the data is saved to the 150 TB RAID storage unit and processed on a high-performance computation 

unit with two 14-core Intel Xeon CPUs, three GeForce GTX1080 GPUs, and 256 GB RAM. 

Lux DATA is a comprehensive data processing and storage solution, designed to effectively handle the 

vast amount of data generated by light-sheet fluorescence imaging. It boosts productivity by relieving the 

need to constantly duplicate or transfer data sets in processing and analysis workflows. Lux DATA enables fast 

data transfer, even during acquisition, and large-capacity storage; as well as remote access and high-

performance processing of multi-dimensional image data and leveraging multi-core and multi-GPU-based 
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computation. The Lux DATA approach seamlessly complements image acquisition with Bruker Light-Sheet 

microscopes – by enabling all subsequent data processing steps and saving time and money. 
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2. System Startup  

 

2.1. Power on the system 

 

• Turn ON the system by flipping the switch on the power supply box. Make sure the emergency button 

is in its release position (rotate to release). After approx. 1 minute the stages will initialize.  

• Turn ON the camera. 

• Start the LuxControl software and make sure the LuxDatahub is running and has connected with the 

camera. If the LuxDatahub is missing the camera that is turned ON, restart the camera and the 

LuxDatahub.  

• The system requires about 1 hour to reach temperature equilibrium with absolute stable optical 

properties.  

• Stack and Channel properties are stored in the embedded controller of the microscope. Power outage 

or shut-down will therefore result in loss of Stack, Channel and Event settings.  

• The optical alignment of the microscope correlates with system temperature and may change due to 

temperature shifts. To ensure optical stability, the microscope needs a constant room temperature and 

requires about 1 hour to reach its working temperature and have thermally stabilized.  

• Coarse alignment (if required see below) can be conducted 15 minutes after turning on the 

microscope, while the fine alignment should be conducted shortly before acquisition and in the 

required imaging solution and can be adapted later in the sample itself. Changes in refractive index, 

e.g. due to evaporation influence the alignment properties and will induce optical shifts. It is 

recommended to use the cuvette lid to avoid evaporation, especially if toxic reagents are used. 
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3. Lux Control Overview  

 

3.1 Abbreviations 

 

• LSA:   light-sheet alignment 

• ROI / FOV:   region of interest / field of view 

• CS:    cleared sample 

• N.V.:    not visible 

• RI:    refractive index 
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3.2 Software 
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Navigation Tabs 
 

 

• “Dashboard”: All control panels needed for 
an experimental setup 

• “Channels”: Selected control panels that 
contribute to the channel setup 

• “Stacks”: Selected control panels that 
contribute to the stack setup 

• “Experiment”: Selected control panels that 
contribute to the experiment setup 

• “Calibration”: All control panels needed for 
alignment and calibration of the microscope 

• “Data streams”: Opening the window 
showing the different camera streams 

• Image Processing: Selected control panels 
that allow setting up and starting the Image 
processing pipeline for image registration, 
fusion, resizing and storage 

 
 

 

Control buttons  
 

 
 

 

• “Start live”: Starting live mode of all cameras 

• “Snap”: Acquires a single image of all 
cameras 

• “Run”: Starts the image acquisition, defined 
by the “Channels”, “Stack” and “Experiment” 
setup 

• “Stop”: Halts and finishes the running 
acquisition 

  
Illumination 
 Laser 

• Laser “ON” or “OFF” setting. 

• Laser intensity setting between 0 and 100% 
with “0%” being the lowest and “100%” the 
highest possible laser power.  
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Beam axial position 

• This setting changes position of the center of 
the beam in lateral direction,  which is 
reflected as moving the beam left and right 
on camera FOV. 

  

Detection 
 

 
 

Selection to change light modalities for the 
respective channel. Set the beam modality and 
patterns according to sample size, signal strength 
and FOV. 

• “Bessel”: A non-diffractive beam pattern that 
has uniformed beam profile over larger field 
of view; 

• “Gausssian”: Typical beam profile used on 
light-sheet microscope. It is a diffractive 
beam so the depth of focus is relatively small 
as compred to Bessel, smaller beam width 
results in more concentrated energy but 
smaller depth of focus; 

• “Lattice”: Carefully crafted coherent 
superpositions of Bessel beams to provide a 
compromise between light-sheet thickness 
and sidelobe energy density; 

• “Lattice hexgonal”: The hexagonal lattice has 
a narrow propagation invariant beam waist 
surrounded by a series of sidelobes that grow 
in strength with increasing propagation 
length, which provides superior axial 
resolution; 

• “Lattice rectangonal”: Consists of a thicker 
central beam lobe that grows in size with 
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increasing propagation length but has small 
side lobes, achieves a more favorable 
balance between optical sectioning and axial 
resolution; 

• “Static lightsheet”: A static planar sheet, 
which provides a stable and static light dose 
on the sample, is usful for applications that 
require quantitive analysis of photons; 

  
Detection 
 

 
 

Selection to change filters for the respective 
channel: 

• Filter wheel: Setting the filter for the actual 
channel. “Empty” positions will allow all 
wavelengths to be transmitted to the 
camera. 

• Magnification Changer: Setting individual 
tube lens for differnet levels of 
magnification. 

• Dichroic Switch: Setting the dichroic switch 
to seperate channels between Cam_Short 
and Cam_long. 

  
Camera 
 

 

Setting of camera acquisition properties.  

• Exposure time: Possible exposure time range 
from 1 – 5000 ms.  

• Delay: Camera delay is set to 11 ms by 
default. This delay is the time that is required 
to readout data from the full camera chip 
(2048 px x 2048 px → 11 ms). A cropped FOV 
in the Y-axis allows to reduce the delay (e.g. 
2048 px x 1024 px → 8 ms delay possible). 

 
Stages 
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Buttons: 

• “Stop”: halts all stage movements  

• “Zero Y & Z”: Moves Y and Z stage to zero 
position 

• Store icon: Sets current position to zero 

• “Zero”: Move to zero position 

• “|<< / >>|”:  Move to minimum / maximum 

• “  << / >>  “:  10x increment 

• “   < / >     “:  Single increment 

• “Enable coupling with”:  Turns ON 
synchronous movement of coupled stages 
(coupling is done via the calibration tab). 
Coupled stages are not displayed.  

Input: 

• Stage Position (µm): Input for specific stage 
position  

• Step (µm): Sets increment (default 10 µm) 
Stages: 

• X: horizontal (back to front) 

• Y: horizontal (left to right, along the 
illumination axis) 

• Z: vertical (along detection axis) 

• CR: Correction Ring 
 
 

 

Channel 
 All “Channel” relevant settings are combined in a 

preset labeled channel_#. Channel presets can be 
selected from the drop-down list 
 
Settings include: 

• FOV (bottom): cropped detection 

• Laser: active laser wavelength and intensity 

• Scanner: amplitude and offset (view 
corresponding setting) 
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• Camera timing (n.v.): exposure time, delay 
and chip mode (area vs. line mode) 

• Filter Wheels (n.v.): selected filters 

• External Trigger(n.v.): Customizable trigger 

• Beam (n.v.): beam expander setting 

• LSA (n.v.): light-sheet alignment setting 
 
Buttons: 

• “Add”: stores current settings to preset 

• “Remove”: deletes current preset 

• “Apply”: loads preset settings to the UI 
panels and sets the components on the 
microscope accordingly 

• “Update”: overwrites current preset with 
modified/current settings from the UI panels 

• “Delete all”: deletes all presets 

• “Save channels”: Stores current preset to be 
available after a power cycle 

• “Load channels”: Loads previously stored 
channel preset 

 
 

 

Stack 
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All Stack relevant stage settings are combined in a 
stack_#. Stacks can be modified within the panel and 
selected from the drop-down list.  
 
Buttons: 

• Arrow button: Inputs current stage position 

• “Add”: stores current settings to a new stack 
preset 

• “Remove”: removes current stack preset 

• “Move to start”: moves stage to first slice of 
the stack 

• “Move to Center”: moves stage to mid slice 
of the stack 

• “Move to End”: moves stage to last slice of 
the stack 

• “Delete all”: removes all configured stack 
presets 

• “Save stacks”: stores current stack presets to 
be available after a power cycle 

• “Load stacks”: loads previously stored stack 
presets 

 
Stack settings:  
Current position can either be used by pressing the 
arrow button or a number can be typed into the 
input box.  
 

• Start: First slice of stack 

• End: Last slice of stack 

• Center: Mid slice of stack 

• Planes: Total number of planes distributed 
equally between first and last slice. For stack 
defined by center slice an uneven number of 
planes is required 
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• Repetition: Number of repetitions of the 
stack. To increase speed, the stack is 
acquired bidirectional with every uneven 
repetition acquiring from first to last and 
every even repetition acquiring from last to 
first slice. 

• Delta: Required value for stack and tiling 
properties. In a stack delta defines the 
distance between each Z-slice. In a tiled 
acquisition (X and Y) the delta defines the 
maximum allowed distance between 
subsequent tiles in X and Y (should be chosen 
to be slightly smaller than the actual FOV). 
The delta is calculated from the start and end 
position and distributes the tiles equidistant 
in X and Y. 

  
Event 
 

 

An Event_# arranges the acquisition and defines 
which Task (combination of Stacks and Channels) is 
acquired in which timely manner (Trigger).  
 
Events are acquired in sequence as defined by their 
delay.  
Buttons: 

• “Add”: opens a new Event 

• “Remove”: deletes current Event 

•  “Delete all”: deletes all configured Events 

• “Save events”: stores current Events to be 
available after a power cycle 

• “Load events”: loads previously stored 
Events 

  
Tasks 
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A Task_# defines the acquisition sequence of stacks 
and their optical configuration. 
Buttons: 

• “Add”: adds a new Task 

• “Combine”: allows to choose suitable 
combinations of different Stacks, Channels 
and their optical Configuration with a defined 
hierarchy.  

• “Delete all”: deletes all configured Tasks 

• Minus Button: deletes single Task 
combination 

 
 

 

Trigger 
 

 

A Trigger_# defines the timing of the Task.  
 
Buttons: 

• “Add”: adds a new Trigger 

• “Delete all”: deletes all configured Triggers 

• Minus Button: deletes a single Trigger 

• Start After: sets the delay of the Event in 
Hours, Minutes and Seconds 

• Interval: sets the interval of the Event in 
Hours, Minutes and Seconds. If the interval is 
set shorter than the duration of the Event, 
the next Event acquisition will start directly 
after the previous 

• Repetition: sets the number of repetitions of 
the Event  

  
Scanner calibration 

(Calibration Tab) 
 

 

Calibration of the scanner properties, how the beam 
is scanned across the field of view 
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• Mode:  
o Park: Parks the Gaussian beam at the 

zero position 
o Scan: Scans the Gaussian beam across 

the FOV with the set amplitude / scan 
range. 

o Automatic scan: Sets the zero position 
and amplitude detected during “Line 
calibration”. Set for “Line” acquisition 
mode (obligatory). 

o sim: Define number of phases (3, 5 or 7) 
and period dimension (please refer to 
Beam Profile doucment for the 
measured period of differnt beam 
patterns) for Structctured Illumination. 

• Offset: Manual displacement of the beam’s 
zero position 

• Store icon: Sets current beam position to 
new zero position 

• Amplitude: Sets the scan range of the beam 
 
 

 

Line calibration 
(Calibration Tab) 
 

 

Line calibration synchronizes the “slit detection” 
readout of a defined number of horizontal pixel lines 
on the detector with the scanning movement of the 
Gaussian beam across the FOV. For a proper 
detection of the Gaussian beam, the “parked” beam 
needs to be clearly visible. 
 
Buttons: 

• “Start” / “Next”: Starts the automated 
calibration or moves the beam to the next of 
three detection positions. 
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• “Retry”: For correct alignment the blue line 
needs to be positioned precisely on top of 
the Gaussian beam to indicate a correct 
detection. In case the blue line does not 
coincide with the position of the beam, press 
“Retry” to acquire a new frame and initialize 
the beam detection on that new frame. 

• “Cancel”: Aborts the process of line 
calibration. 

 
Tips: 

• If the blue line does not detect the Gaussian 
beam accurately, increase laser power or 
exposure time and try different filters. 

• Changing the scanner offset requires a new 
line calibration. 

• Low or inhomogeneous signal in line mode 
but a correct detection in area mode hints 
toward a faulty line calibration. 

• The calibration has to be done for each 
magnification individually 

 
A successful calibration will be indicated in the panel 
by a green checkmark next to the magnification in 
the dropdown menu that has been calibrated.  

 
 

 

Lightsheet alignment 
(Calibration Tab) 
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Light-sheet alignment in Y and Z 
 
Buttons: 

• “Store:” Stores current settings as default for 
next microscope start up 

• “Y1”: Rotating the light-sheet  direction on 
the focal plane, can be adjusted by observing 
the camera live view when beam is parked;  

•  “Z1”: Rotating the light-sheet direction 
perpendicular to the focal-plane, tricky to tell 
directly from camera live view, can be 
adjusted by moving the beam left and right 
on FOV and observe if there is any focus 
change; 

• “Y2”: Shifting the beam waist on the focal 
plane, can be adjust by observing the beam 
center position using camera live view when 
beam is parked; 

•  “Z2”: Shifting the beam waist perpendicular 
to focal plane, can be adjusted by observing 
the beam focus using camera live view; 
 
 

Objectives 
(Calibration Tab) 
 

 

Upon objective exchange, the objective properties 
have to be selected for accurate metadata 
configuration. 
 

• “Right/left illumination objective”: 
Dropdown menu for illumination objective 
configuration selection 

• “Detection objective”: Dropdown menu for 
detection objective configuration selection 
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• “Store:” Stores current selection as default 
for next acquisition and microscope start up 

 
 

 

Stage coupling 
(Calibration Tab) 
 

 
 

Required stage coupling pairs (master – slave): 

• Z – Y:  horizontal moving of sample holders 
 
Stage coupling allows the synchronous movement of 
two stages in a master-slave fashion with a linear 
correlation between the two stages. Two or more 
stage positions are required. With three or more 
reference stage positions a linear interpolation is 
calculated from all position pairs.  
 
Buttons: 

• Ref stage: Select master stage 

• Linked stage: Select slave stage 

• “Add”: Adds a new coupling pair with current 
stage positions of the selected two stages. 

• “Add stage position”: Adds new (current) 
stages position pair to existing coupling list.  

• Trash icon (next to the coupling pair – n.v.): 
Removes value pair from coupling list 

 
The master stage of a coupled stage pair shows the 
“enable coupling with…” switch in the “Stage” panel 
as soon as coupling (two or more coupling pairs exist 
for the according master-slave pair) is performed. 
Enabling coupling, removes the coupled (slave) stage 
from the Stage panel. Moving the master stage now 
also moves the coupled stage synchronously. 
Coupled stages can be made visible again via 
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disabling the stage coupling or in the “Calibration” 
tab. 

 
 

 

Camera Properties 
(Data Stream) 
 

 

Possibility to input ROI cropping parameters, by 
defining the Top, Left pixels as well as Height and 
Width of the ROI. 
 
“Reset Crop ROI” resets cropping to full 2048 px by 
2048 px.  

 
 

 

Data Stream 
 

 
 

In the Data Stream window, the camera is shown as 
a sub-window.  The ROI can be adjusted by drag-&-
drop of the blue squares in the corners of the live 
image. For the selected stream the LUT can be 
adjusted manually by drag-&-drop of minimal and 
maximal grey value slider in the histogram panel.  
 
Buttons: 
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• “Close all streams”: Closes all stream 
windows 

• “Add data stream”: Opens new stream 
selected from dropdown menu 

• “Size” slider: Changes window size of all 
streams 

• “Crosshair” / “Ticks” (n.v.): Overlays 
Crosshair / Ticks on stream 

• “+ / -“ : Zooms in and out of stream 

• Brightness/Contrast: Switches between 
automatic and manual LUT settings  
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4. Microscope alignment 
 

4.1 Alignment 

 

• The alignment is required to compensate for temperature shifts in the room and for small optical and 

chromatic shifts in the optical components of the microscope to achieve maximal acquisition quality. 

• Coarse alignment should be conducted upon objective exchange or long down time of the system, 

prior to mounting the sample. Water with a very low concentration of fluorescent dye (text marker / 

fluorescein) or cell culture medium provides good fluorescent properties to find and coarse-align the 

Gaussian beam. 

• Fine alignment is required prior to each experiment and has to be conducted in the imaging medium 

(e.g. refractive index matching solution - RIMS) as small changes in the refractive index can cause large 

changes in image quality. 

• Ultra alignment (color channel shift / focusing) can be conducted in the sample but with delicate and 

photosensitive samples the alignment procedure should be conducted outside the ROI and with 

carefully selected illumination parameters or by only using the “Snap” functionality. 

 

4.2 Coarse alignment 

 

AIM: Visible Gaussian beam 

• Use water with small amounts of fluorescent dye added or culture medium. Plain water also works but 

requires higher laser power for the alignment. 

• Move both y and z axis to “Zero” position. 

• Close sample chamber cover and trigger the laser safety button (on the side of the sample chamber). 

• Switch to “Calibration” Tab 

• In the “Scanner Calibration” panel: set Scanner to “Park”  

• Turn ON 488 laser (or any other low wavelength laser available on the system) at 30-100% output 

power depending on media fluorescent content. 
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• Select corresponding filter and dichroic mirror (Filter short: LP498, Filter long: LP 498, Dichroic: empty). 

• Set exposure time to 50 - 200 ms. 

• Set beam to Gaussian and diameter to 1. 

➔ The Gaussian beam should be now visible 

• If the beam is not directly visible check the following steps: 

o Recheck settings from above: 

- Are both objective lenses fully immersed? 

- Sample chamber cover closed? 

- Interlock triggered? Press Interlock release button (listen to faint clicking noise) 

- Scanner set to “park”? 

- Laser switched on? 

- Appropriate filter chosen? 

- In “Live Mode”? 

- Is the LUT setting wrong? Set the LUT to “Dynamic” and full zoom out in the FOV using 

“minus” button. 

o Moving Alignment Z by in 0.1 steps in both + and – directions to find the beam if needed. 

Tips: 

• If you use water: adding small amounts of fluorescent dye or using culture medium instead helps 

increasing the fluorescent signal. Plain water also works but requires higher laser power for alignment. 

• Cell Culture Medium, PBS or organic clearing solutions have usually a higher autofluorescence / 

fluorescent particle and therefore require less laser power, shorter exposure times.  

• Setting the LUT range of the camera histogram manually (instead of using “dynamic”) can avoid the 

image fluctuations seen in low fluorescent alignment solutions.  

 

4.3 Fine alignment 

 

AIM: Focus beams and move focused beam waist to the desired lateral position of the FOV 

• Switch to the “Calibration” Tab. 

• In the Scanner calibration panel, set scanner to “park”. 
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• Position the beam waist into the focal plane 

o Set beam pattern to “Gaussian” and diameter to “1”. 

o Focus the beam with Alignment Z2+/- (in steps of 0.01). 

o Move beam waist to center of the FOV with Alignment Y2+/- (in steps of 0.01). 

o Adjust horizontal beam tilt with Alignment Y1 +/- (in steps of 0.01) 

o Adjust orthogonal beam tilt with alignment Z1 +/- (in steps of 10). The orthogonal beam tilt 

might not be directly visible from the beam appearance. To test for orthogonal tilt, focus the 

beam in the center position, and move the beam waist left and right using Alignment Y axis, if 

the beam is orthogonal tilted, it will get out of focus towards edge of camera FOV. 

o Press the “Store” button to save the LSA Z position for the next startup of the microscope 

Tip: 

To have an extra criterion of being in focus with the beam during LSA in Z (besides the criterion 

of having the smallest beam waist), look at the histogram: the brightest value moves up and 

down in intensity when moving the beam in Z. The beam is in focus when the histogram shows 

the brightest broad peak at the highest achievable value. 

4.4 Ultra alignment 

 

For ultra-alignment, please refer to the “Service & Application Manual AIM”. Normally it has 

been completed during installation and regular maintenance. 

4.5 General topics about alignment 

 

• In general, the alignment of the microscope will be marginal, with only minor corrections to the startup 

settings, if the external conditions have not changed. 

• Key reasons, that can result in major misalignment and the need of a coarse alignment of the system 

are: 

o Exchange of objectives 

o Substantial temperature differences 

o Difference of refractive index 

o Non corrected chromatic aberrations (405 nm laser) 
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General pitfalls: 

If the sample is mounted, the stages moved to the imaging positions, and the first settings have been adjusted 

to the specific sample, but still no sample can be detected in the “Live” mode or the image quality is extremely 

bad, check / try the following: 

 

•  Not enough water/medium in the imaging chamber to fully cover the objective lenses and touch the 

bottom of the sample holders. 

➔ reduce the Z-stage position 

 

• Z-stage is raised too high, resulting in the sample being above the illumination optical axis 

➔  reduce the Z-stage position 

 

• Wrong illumination/detection settings 

➔ Adjust laser, laser power, filters, exposure time 

 

• No illumination upon pressing “Start Live” / closed interlock 

➔ Press interlock release button 
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5. Sample preparation 

A good sample preparation and mounting is key to a successful imaging session. Proper sample 

orientation allows to minimize the distance light has to travel inside the sample. Additionally, for multi-

colour, multi position, multi time point imaging, a proper mounting ensures stable imaging properties. 

The following tips should be considered for sample mounting: 

• Is my sample properly attached to the imaging plate? 

FEP surfaces may not provide sufficient adhesion for cells. Hydrophilization treatment can increase 

adhesive properties of the sample chamber. Plasma treatment the FEP sample holders before seeding 

cells will help cell adhesion. Glass slide can also be used for cell samples. 

• What is the optimal orientation for my sample? 

Proper orientation of sample can improve in-depth imaging,  Z-stack alignment, and minimize 

aberrations. In general, reducing the distance the light has to travel between the region of interest and 

the detection objective as well as an orthogonal angle between detection optical path and sample 

surface improves image quality. Therefore, it is better to make sure the sample is close to the bottom 

of the sample chamber with the regions of interests facing towards detection objective. 

• What makes navigation within the sample chamber easier? 

Use LED light to quickly browse through the sample chamber and look for samples. Please make sure 

LP (not BP) filters are selected, camera mode should be selected as Area mode with an exposure time 

of 5-20 ms to avoid over-exposure.  

• The heated incubation plate can be pre-warmed: 

As soon as the temperature controller is turned ON and the heated incubation plate is connected to 

the microscope it will be heated to 37°C even if it is not mounted to the microscope stage. This will 

enable a faster temperature stabilization and optimal culture conditions. 

• Optimal imaging plate mounting for long time lapse acquisition: 
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Sample shifts in time lapse acquisition can be a result of inadequate imaging plate mounting or instable 

mounting solutions (agarose / hydrogels). To ensure the optimal mounting of the imaging plate to the 

heated incubation plate, make sure the springs fastening the imaging plate are attached properly and 

the imaging plate is in full contact with the glass by gently pressing the imaging plate down, before 

mounting the set onto the stage. 

• Autofluorescence for quicker sample navigation: 

Agarose, Hydrogels and tissues always display a low to medium amount of autofluorescence. By using 

the 488 nm laser at low intensity and detection without any filters, this autofluorescence can be 

detected and facilitates sample navigation, with a minimized photo induced effect on the sample, due 

to the extremely low laser power required. 
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6. Image acquisition 

 

Tips to improve image acquisition quality and help image processing/analysis are: 

• Adjust beam diameter to sample size: 

A thinner waist will increase signal intensity and reduce signal-to-noise ratio on a narrow ROI, while for 

homogenous illumination throughout the FOV, a thicker beam diameter should be selected 

• Focus experimental setup and reduce data size: 

As the data size increases significantly with every additional time point, additional tile, additional Z-

stack slice number, and additional channel, a key focus should be to avoid an immoderate amount of 

data, as this will facilitate faster data processing and analysis. Especially during the establishment 

phase, a reduced time resolution and minimal Z-stacks will improve the overall experiment 

development process. 

• Homogenous refractive index: 

Changes in the refractive index will introduce optical aberrations in the detection path. Materials like 

low melting Agarose, Matrigel, salt concentrations in imaging media or degraded clearing solutions can 

have small but noticeable differences in refractive indexes. Equilibration between different chemical 

components such as Agarose and the surrounding imaging solution or old and fresh clearing solution 

will improve the image quality over time (1-2 hours), but all components should be applied, to provide 

a homogenous refractive index. If RI mismatches, such as introduced by Matrigel, cannot be 

compensated the interface between Matrigel and the surrounding culture medium should be 

orthogonal to the detection axis to reduce spherical, aberrations. 
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7. Data Review 

 

7.1. Luxendo InVi SPIM File Naming Conventions 

 

7.1.1. Folder Hierarchy 

After an acquisition is initiated, a new experiment folder is created and named with the date and time the 

experiment was initiated; for example, an acquisition on November 15, 2019 at 01:50:54 am becomes 2019-

11-15_015054. 

 

Within the main experiment folder, sub folders are created for every stack (ie. stage position) and channel 

combination. Each folder will be named, stack_(n)_channel_(n).  

 

The sub-folders created for tiled montage acquisitions will have the same stack number and include the X and 

Y coordinates of each tile position. These sub-folders contain files related to the images and meta files 

generated by the short and long cameras.  
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7.1.2. Image Data 

• Image data for each stack and channel combination is stored in the Cam_Long_00000.h5 and 

Cam_Short_00000.h5 files 

o H5 files are an open source format that can be opened in FIJI 

• Time series will have multiple .h5 files and be named according to time point (ie. 

Cam_Long_(*****).h5 where (****) is the timepoint 

 

7.1.3. Meta Data 

• The Cam_Long.JSON and Cam_Short.JSON files contain the metadata for each acquisition and can be 

opened in Notepad to view the microscope setting each for the experiment 
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7.2. Viewing InVi SPIM Data in FIJI 

 

7.2.1. Downloading and Configuring FIJI  

1. Download the latest 64-bit version of FIJI from https://fiji.sc/ 

2. Open FIJI > select Edit > Options > Memory and Threads 

3. Set the Maximum Memory to match to the amount of RAM installed on the computer 

a. This setting will limit the size of the data sets that can be directly loaded in FIJI 

b. Maximum Memory can exceed the amount of RAM if Virtual Memory is enabled in Windows  

 

https://fiji.sc/
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4. Select Help > Update > Manage Update Sites > check boxes for EMBL-CBA and HDF5 > Close > Apply 

Changes 

 

7.2.2. Opening Single Cam_(Long or Short)_00000.h5 Files 

5. For single H5 files, Select File > Import > HDF5 > select Cam_Long_00000.h5 or Cam_Short_0000.h5  

6. Repeat this process to open additional data from other stacks, channels or camera angles 

 

• Note: file sizes will be limited to the memory allocation configured in the FIJI Settings menu. Any 

files opened with this method will be stored in the computer's RAM.  
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7.2.3. Streaming Time Series with the Big Data Processor 

7. Stream large data sets, such as time series with the Big Data Processor in FIJI to bypass the memory limit 

of the computer and take advantage of the H5 file structure 

a. Select Plugins > BigDataTools > BigDataProcessor > select folder of interest 

b. Steaming data with the BigDataProcessor does not load the entire file to RAM  

 

c. Input camera specific information into the Only load files matching: field, ie. Cam_Long_0.*h5 

i. The file name information will be found in the data folder 
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ii. Remove any numerical characters at the end of the file name and replace with “0.*h5” 

1. For example, Cam_Long_00000.h5  would be inputted in the Only load files 

matching: field as Cam_Long_0.*h5 

d. Select Hdf5 data set name: Data from the drop-down menu 

e. Click Open Virtual 

 

a. To open other camera angles, repeat process starting at Step 3a by inputting Cam_Right_0.*h5 

into the Only load files matching: field of the Big Data Processor window 

b. To open other channels or stage positions, repeat process and select appropriate folder in Image 

Data Folder window of Step 3a 
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7.2.4. Opening Data Collected in Repetition Mode 

8. For data acquired in Repetition mode, open data in FIJI using File > Import > HDF5 file > select Cam file of 

interest > Open > highlight data set path "Data" > click Load 
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a. If two channels were acquired, repeat this process to open the second Cam view 

i. For two color samples imaged using dual channel simultaneous capture, one data set may 

need to be flipped (depends on the model InVi SPIM used for acquisition) 

1. Select Image > Transform > Flip horizontally 

ii. The two channels can be overlaid by selecting, Image > Color > Merge Channels 
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a. During conventional capture time points are saved as distinct files, this takes a lot of computer 

overhead and makes the acquisition slower. When using Repetition mode the files are saved as 

one file - this format is typically reserved for Z. To correct this, select Image > Properties > switch 

values automatically generated in Slices (z) to Frames (t) 

a. In the below example, Slices (z): 1000 becomes Slices (z): 1, and Frames (t): 1 becomes 

Frames (t): 1000 
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b. The Frame interval can be determined from the JSON file by adding the "Delay after ms" and 

"Exposure ms" values 

   

 

 

 

 

 

 

 

 

7.2.5. Opening Data Processed with the Luxendo Image Processing Pipeline 

9. For raw data fused or stitched using the Luxendo Image Processing Pipeline, an "Output" subfolder will be 

present in the experiment's main folder. Depending on how the fusion was performed, this folder may 

contain compressed versions of the raw data and the fused data. 
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a. These data can be opened within FIJI using File > Import > HDF5 (Step 2) or with the 

BigDataProcessor plugin  

i. To use the BigDataProcessor plugin, follow the directions outlined in Step 3 with the 

following data-type specific changes: 

1. The Open load files matching: field must contain the H5 file name without the 

numerical characters + 0*.h5 

a. For example "out_stack0-x00-y00_chan0_camFused_tp00000.h5" becomes 

"out_stack0-x00-y00_chan0_camFused_tp).*h5 

2. Select Data111 from the Hdf5 data set name: drop-down menu  
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10. To use Big Data Viewer plugin, select Plugins > BigDataViewer > Open XML/HDF5 > select "_master_bdv" 

XML file of interest > Open 
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7.3. Opening InVi SPIM Imaging Data in Arivis Vision4D and Imaris 

Once the imaging data has been appropriately fused/stitched in the Luxendo Image Processing Pipeline, the 

channels and time points will open in a single window in Arivis Vision 4D or Imaris (depending on the features 

of the software package being used). 

• The "_master_bdv" XML file can also be dragged and dropped into Arivis Vision4D for rendering and 

analysis 

 

• The "_master_imaris" Imaris Image file can be double clicked to open in Imaris or Imaris Viewer 

1. The free Imaris Viewer for Mac and PC can be download from: https://imaris.oxinst.com/imaris-

viewer 

 

  

https://imaris.oxinst.com/imaris-viewer
https://imaris.oxinst.com/imaris-viewer
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7.4. Luxendo Image Processor 
 

Image processor is integrated part of our Lux Control instrument software interface. 

Images given to the Image Processor are in the Luxendo-Image format (.lux.h5) and contain important 

metadata, including transforms that bring the image data from the "pixel space" of the cameras to the 

"sample space", the 3d-coordinate system in which the sample is represented. 

The Image Processor performs the following steps: 

1. (Optional) Registration (content-based): align the different objective views, tiles, and rotated views 

against the selected "reference" view, to get finer "correction" transforms to sample space (in addition to the 

transforms from the image metadata, e.g. from stage positions). The resulting transforms are saved to 

.transf.json files in regis... subfolders in the output folder. 

2. Fusion: the different views are transformed to sample space and fused. This produces a separate 

output .lux.h5 file for each time point and channel. 

3. Generate main files that link to the output-data files for all time points, channels, etc (e.g. a .ims main 

file to open the output images in Imaris, and .xml, .h5 files for Fiji BigDataViewer). 

The settings for each step can be found in the corresponding sections in the GUI. For specific information on 

the individual settings, please also see the tool tips in the GUI (they are shown when pointing at the label of 

the respective setting). 

When Fusion is deactivated, no output images will be produced. This is useful if only the transforms from the 

content-based registrations are needed. 
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7.4.1. Tasks 

 

The Image Processor allows to set up multiple separate processing "tasks", with different settings and/or 

different input images. Then many tasks can be enqueued and run one after the other, without need of 

supervision or interaction from the user, and the results of all completed tasks can be evaluated at a later 

time. Each task is run as a separate process on the computer. A task's output is saved to a separate output 

folder (named with task name, time stamp, and user-provided task description) within the processed folder, 

inside the "experiment" folder that contains the used raw input images from the acquisition. 

A task can have different statuses: 

• Not started: a new task. 

• Queuing: the task is enqueued and waiting to be run, when the tasks that are ahead of it in the queue 

are completed or have been stopped by the user. 

• Running: the task is currently running, and output is being written to its output folder. 

• Stopped: the taks was manually stopped by the user. For instance when the user realized that the 

settings needed to be changed or another task behind it in the queue was more important and should be run 

first. 

• Failed: the task has failed with an error. This error is shown in a red error notification. A Failed task can 

be started again, e.g. after adjusting its settings, or to try it again with the same settings. 

• Completed: the task is completed. It can not be run again. 

All present tasks are shown in the task-list panel. When clicking on a task in the list, its settings (configuration) 

are shown in the configuration panel, and can be changed (unless the task is currently Running or is already 

Completed). For each task, all its settings are saved in a config_task.json file in its output folder, when the task 

starts to run. 
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• Newly added by clicking the Add button. A new task will show up in the task list with a new name 

(number), for which the user can then provide a description to easily identify the task later, and adjust the 

settings of the task. 

• Copied by clicking the Copy button. All settings of the task will be copied to a new task created in the 

list. This is particularly useful when e.g. another task should be run that has mostly the same settings but only 

a few specific settings need to be changed. 

• Exported (saved) as a .json file that contains all the settings of the task, by clicking the Export button. 

• Imported, by clicking the Import button and selecting the .json file of a task that is e.g. in the output 

folder of a previously run task, or that was exported before. 

• Saved as new default settings: by clicking the Save as default button, the settings of the currently 

selected task will be saved as new defaults, so that whenever a new task is added afterwards, it will at first 

have these settings. This function can be very useful, when the user often needs the same settings, but these 

settings are different from the pre-configured defaults. 

• Deleted: the task will be only deleted from the task list, but its output folder will not be deleted. 

• Run: the task will be added at the end of the queue of tasks (enqueued) and will be waiting until it is its 

turn to run. 

• Stopped: the task can be manually stopped by the user, e.g. to change the settings, or to let other 

more important tasks that are behind it in the queue run first. 

 

7.4.2. Usage Level 

 

With the Usage Level slider, the power/difficulty level can be chosen, and the corresponding controls for the 

settings of a task will be accessible in the user interface. The settings that are not shown at a chosen level are 

set to their default values. The levels are: 
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• Basic (0): only the most commonly used controls are accessible. 

• Intermediate (1): settings are accessible that provide more fine-grained control, e.g., if a sample 

requires specific registration settings. 

• Advanced (2): these are settings which advanced users can use to fine-tune the processing results. 

• Additional (3+): if additional features are installed with the Image Processor, these can be accessed 

with level 3 or higher. If no additional features are installed, the Usage Level slider will only go up to 2. 

Should a setting that is mentioned in this guide not be visible in the user interface, please try if it shows up in a 

higher Usage Level. 

 

7.4.3. Typical Workflow 

 

A typical workflow has usually two phases: 

1. Run multiple fast low-resolution "test" processing tasks, to test different settings quickly and find the 

settings that lead to the desired result. We recommend setting the parameter Output > Down/Up-sample 

Factor to 2 or larger (e.g. factor 4), to speed up the processing and keep the output small. This factor has a 

very large effect on run time and output size, since it is applied in all three dimensions of the output images. 

2. Once good settings have been found in one test task, copy the task to a new task and run this task with 

full-resolution output (factor 1), to produce the final result. 

In Phase 1, often the following tasks with low-resolution output are useful (Tip: copy the first task and only 

change specific settings): 

1. A task without content-based registration (Registration tab switched off), to see if the alignment of 

views / tiles from only the transforms in the input-image metadata is roughly correct. Tip: To also get the 

original views in sample space as output, in addition to the fusion result, choose the option Output > Add 

Views Separately. To be able to view the original, aligned data separately can often be helpful. 
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2. A task with the desired content-based registrations, e.g., Objective Registration, Tiles Registration, to 

see the effect of the content registration. 

3. When satisfied with the content alignment, copy this task to a few tasks in which different settings for 

the Fusion are tried out, e.g., different choices for Mode: WeightedSum or HighestWeight. For these tasks, you 

can use Registration > Reuse Registrations from Task (folder) to select the previous task with the good 

alignment, to reuse its registrations. This can shorten the processing time significantly. 

In Phase 2: 

• When good Registration and Fusion settings are found in a task in Phase 1, copy this task and set the 

output resolution to full resolution (if desired), i.e., Output > Down/Up-sample Factor to 1. Also here, to 

shorten processing time, you can use Registration > Reuse Registrations from Task (folder) to select a previous 

task which obtained satisfying content alignment. (If the selected previous task had a lower output resolution, 

this does not affect the accuracy of its registrations -- its registrations can be reused by a task with higher 

output resolution.) Then run this final task. Due to the high resolution, this task will take significantly longer 

and create much larger output-image files. Tips: 

o Note that choosing full resolution (especially isotropic) can lead to very large output-image data, and 

may not always be necessary, depending on further use of the data. 

o Add Views Separately usually only makes sense for low-resolution "test" tasks (Phase 1). It should be 

switched off in high-resolution tasks, since there it leads to much longer processing times and much larger 

output data (each view added will have the same size as the fusion output). 

 

7.4.4. Registration (content-based) 

 

The Registration phase of the Image Processor tries to improve the rough to-sample-space transforms from 

the input-image metadata by aligning (registering) the content of different views / tiles. Only content from the 

same channel will be registered, because the content in different channels can of course be quite different 

and does not necessarily match. 
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The content-based registration is not guaranteed to succeed. Depending on the sample / content, it can also 

fail. It can, for instance, be thrown off by "noise" or other content not of interest to the user, such as edges 

(borders) of images, or small features that are only present in one of the views to be registered. Sometimes, it 

may seem surprising that a seemingly easy alignment task does not give a satisfactory result. Please keep in 

mind, however, that the alignment algorithm does not necessarily know what content is of interest to the user 

and what content is irrelevant. The fewer different features / content there are in the views to be registered, 

the more likely it is that the registration will be successful. We try to make our registration algorithms more 

and more robust. So it may be that some registration task that did not work, will work in future versions of the 

software. 

Tip: If the alignment after content registration looks wrong, then run the task again without content 

registration and check that the views are roughly correctly aligned based on the transforms from the input-

image metadata. 

MuVi-SPIM Registration 

Objective Registration: 

• For the MuVi, when input images from different objectives/cameras are present, the option 

Registration > Objective Registration > Register Different Cams needs to be switched on. 

Rotation Registration: The content-based Rotation Registration is only performed on rotated views from the 

"reference" objective / camera (selected in the Input tab). And the resulting transform is then also applied to 

the images from the other objective / camera. 

• It is recommended to calibrate the stage-rotation axis before acquisition, to facilitate the rotation 

registration of the MuVi images. 

• If the different rotated views have significant content/features outside their intersection volume, then 

the option Rotation Registration > Views Are Pre-Aligned should be selected, to use only the intersection 

volume of the views for registration instead of registering in the full volume. Because the content outside the 

intersection volume can throw off the content-based registration. However, this option requires that the 

stage-rotation axis had been calibrated (at least roughly) before acquisition. 
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Tips: 

• If the result of Objective Registration (i.e. multiple objective views present) and Rotation Registration 

and Fusion looks misaligned, then, in a separate task, first only do registration and fusion of the opposing 

objective views (no rotated views), and check that the result is aligned. If not, then the problem already is in 

the registration of the opposing objective views. 

• If the rotation registration fails, try 

i. Select a different "reference" objective / camera in the Input tab. 

ii. Calibrate the stage-rotation axis before the acquisition (check that fusion without content registration 

aligns the rotated views roughly), and then select Views Are Pre-Aligned. 

iii. Switch Do Fine Alignment off. 

iv. Subtract a bit more or less background with the Subtract Constant Background Value parameter. 

QuVi-SPIM Registration 

• For registration of two different objective views for the same stack, use Objective Registration. 

• For registration of two different stacks with different objectives, use Rotation Registration. 

 

7.4.5. Fusion 

 

In the Fusion phase, all selected input views, i.e., objective views, tiles, and rotated views, are fused at once. 

This happens in a chunk-wise manner, to allow 

• fusion of very large images, without running out of RAM 

• (optionally) calculating the image quality in each chunk for each view and in the fusion weighting each 

view's chunk based on its image quality 
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• efficient parallel processing of chunks 

The fusion Mode: WeightedSum and HighestWeight enable weighting/selection of different views based on 

their local image qualities with the granularity of the chunk size -- typically 64 pixels (for details, please see the 

descriptions in the tool tips). Such weighting can be very useful, because it allows "stitching" fusion. This 

provides, for instance, a way to suppress doublings from inaccurate alignments in the output image, which can 

occur in many situations. 

Tip: To ensure that the fused output images can be viewed in Fiji BigDataViewer, the option Fusion > Half 

Intensity should be switched on. This will divide the intensity of the output images by two. 

MuVi-SPIM Fusion 

• For the MuVi, when input images from different objectives/cameras are present, the option Fusion > 

Fuse Different Cams needs to be switched on. 

QuVi-SPIM Fusion 

• For the QuVi, the option Fusion > Load Only Full Chunks should be switched on, to avoid empty spots in 

the fused output images, at the boundary between views (though some content at the edges of the input 

images may be lost when this option is used). 

 

7.4.6. Stitching 

 

When doing stitching of multiple tiles (fields of view), the following points are important: 

• For all tiles, the "reference" objective selected in the Input tab needs to be present in the list of input 

images. 

• Content-based alignment of the tiles can be switched on and configured with Registration > Tiles 

Registration. If this is switched on, all overlapping tile pairs are registered based on the content in their 

overlap regions. Afterwards, the resulting tile-pair registrations are used in a global-optimization procedure, to 
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find the best overall arrangement of the tiles. If any of the registered tile pairs contribute an unusually high 

"cost" during this global optimization, a warning will be shown, since this likely means that the corresponding 

tile-pair registration is wrong or inaccurate and thus disagrees with the other tile-pair registrations. In this 

case, it is recommended to copy the task and run it again, but with Tiles Registration > Remove Outlier Pairs > 

Automatic with Cost Threshold with threshold 10 enabled, to automatically remove these "outlier" tile-pair 

registrations in the global optimization. (Note that often there are anyway more tile-pair registrations than 

needed for a good overall arrangement of tiles, so removing some inaccurate ones will usually lead to a better 

result.) For this new task, the tile-pair registrations from the previous task can be reused, with Registration > 

Reuse Registrations from Task, to avoid doing all the tile-pair registrations again, to save time. 

• For images acquired with relatively small magnification (e.g. < 10x), depending on the use case, the 

alignment of the tiles may already be accurate enough *without* content-based registration (Registration > 

Tiles Registration switched off), i.e., using only the stage-position-based alignment from the input-image 

metadata. If this is not sufficient, the Registration > Tiles Registration can be switched on, to add content-

based alignment. 

• For stitching of tiles, under Output > Bounding Box, the option Union should be selected (because 

Intersection will yield only the overlap of the tiles). 

• If there are strong intensity borders visible between the stitched tiles, you can try to achieve smoother 

transitions between tiles by stitching again with Fusion > Mode set to Maximum. 

Typical workflow for stitching 

Run different "test" tasks with low-resolution output (e.g. Output > Down/Up-sample Factor set to 4 or larger), 

and finally one task with high-resolution output: 

Task 1 (low-resolution output): 

o Registration off, to see arrangement of tiles based on only stage positions (no content alignment). 

o Fusion > Half Intensity on, to be able to view result in Fiji BigDataViewer. 
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o Output > Add Views Separately can be used to enable seeing tiles separately in the viewer later on, for 

easier evaluation of alignment and overlap of tiles. However, this will add a dataset of the size of the full 

stitched image, for each tile to the output, i.e., multiply the output size by the number of tiles. Thus, this is 

only recommended for either smaller numbers of tiles, or strongly downsampled output (large Output > 

Down/Up-sample Factor). 

o Open result in Fiji BigDataViewer, and see how much the sample moved between acquisition of 

different tiles, and whether the chosen overlap size between the tiles was large enough. 

o If the overlap of tiles is too small compared to the movement of the sample (i.e. corresponding 

features are not in the overlap region), then the sample should be re-imaged with 

 better mounting 

 less stage acceleration 

 more overlap 

o If the overlap was sufficiently large, proceed with Task 2. 

Task 2 (low-resolution output): 

o Registration on. 

o Are there warnings about tile-pair registrations with high cost? 

 If so, proceed with Task 3, otherwise go directly to final Task 4. 

Task 3 (low-resolution output): 

o To shorten processing time, you can select Registration > Reuse Registrations from Task > Task 2. 

o Switch on Tiles Registration > Remove Outlier Pairs > Automatic with Cost Threshold with threshold 10. 

o If in the result the alignment of the tiles is satisfying, proceed with final Task 4. 

Task 4 (high-resolution output): 
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o To shorten processing time, you can select Registration > Reuse Registrations from Task > Task 2. 

o Set the Output > Down/Up-sample Factor to the desired final resolution. 

o For stitching, we recommend to set Fusion > Mode to Maximum, for a smoother transition between 

tiles. 

 

7.4.7.  Output 

 

The option Output > Down/Up-sample Factors > Depth can be switched off to produce isotropically sampled 

output images. For the QuVi, the output should normally be sampled isotropically. For the MuVi, isotropic 

output makes usually only sense when rotated views are fused (angular fusion). In the case of only one stage-

rotation angle, for one objective or two opposing objectives, it is recommended to use the original z (depth) 

sampling, i.e., the same number of planes as the input images: Depth (z) sampling factor of 1. 

 

7.4.8. Advanced topics 

 

To only run a conversion of the input images separately to the formats readable by Imaris or Fiji 

BigDataViewer, do the following: 

1. In the Input tab of a new task, select only a single view to be converted. 

2. Switch Registration off completely, and switch Fusion on. 

3. Select output resolution etc in Output tab. 

4. Start the task. 

5. Copy the task for each view to be converted, and in each task only select the respective single view in 

the Input tab. 
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6. Run all these tasks. 

One separate task needs to be run for each view to be converted. The resulting Imaris and Fiji-BigDataViewer 

files will be in the output folders of the different tasks. 

(If there are multiple different views selected in the Input tab in one task, then these will be fused.) 

Run with terminal window 

To run the Image-Processor Server with a terminal window, to see additional status, progress, or error 

messages from the processing tasks, do the following: 

1. Open the Windows Task Manager and go to the "Details" tab. 

2. Sort the processes according to "Name", and end the task "ips.exe". 

3. Open the File Explorer and go to the C:\Luxendo\Image Processor\<latest version> folder. 

4. In the address bar, enter cmd to start a command terminal at this location. 

5. In the terminal, type ips.exe to start the Image-Processor server. 

Now the Image-Processor Server is running with a terminal window, and relevant content (such as error 

messages) can be read and copied from the window. 

 

7.4.9. Troubleshooting / FAQ / known issues 

 

• If the output-image files are unexpectedly large, please consider / keep in mind that: 

o the output sampling may accidentally have been set to isotropic (Output > Down/Up-sample Factor > 

Depth is not checked) 

o the output-image size is rounded to integer multiples of the chunk size (usually 64 pixels) in each 

direction 
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o the output image usually has multiple resolution layers 

• When a task that does Registration or Deconvolution is started while another application (e.g. 

TeamViewer) blocks the GPU, this task may hang (i.e., be blocked in the GPU-based step) until the application 

blocking it is closed. 

• Currently, it is not supported to run Image-Processor tasks and acquisition on the same PC 

simultaneously, because these processes may compete over the access to the RAID / hard drive and this way 

slow each other down. Also sample tracking should currently not be run simultaneously with Image-Processor 

tasks, because they may compete over the GPU as well as the RAID / hard drive. 

• Heavy processing of images in other applications (e.g. Imaris or Fiji) can also negatively interfer with 

running Image-Processor tasks, when they compete over RAID / hard drive or GPU resources. 

• Input images being open in other software, e.g., Fiji, while also being used as input image in a running 

Image-Processor task, can lead to access problems on the side of the Image Processor, and the processing task 

can fail. Please close the input images in other applications before starting the task using them as input. 

• For each task, the Image Processor estimates the disk space required to store the task's output data. If 

there is not enough free space available on the target drive for the output data (e.g. the local RAID), it will 

warn about this and say how much free space is needed. However, third-party software producing data on the 

same target drive, or copy processes to the same target drive, while Image-Processor tasks are already 

running, can still cause the tasks to run out of disk space and fail. We thus recommend to stop or pause such 

external processes that generate data on the same target drive, while Image-Processor tasks are running. This 

will also lead to better performance of the Image-Processor tasks, since input/output from/to a drive is often a 

speed bottleneck for the tasks, and so external processes reading from / writing to the same drive, may slow 

them down significantly. 
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8. Cleaning, Maintenance and Service 

 

The manufacturer cannot be held liable for damages caused by faulty operation, negligence or non-authorized 

procedures, particularly for the removal or exchange of components or use of improper equipment from other 

manufacturers. Any such action voids the warranty and laser safety is not guaranteed anymore. 

 

8.1. Maintenance by manufacturer 

To ensure a smooth operation of the Luxendo InVi SPIM over a long period, we recommend concluding a service 

contract with Luxendo GmbH. 

Damaged devices or parts may only be repaired or replaced by the Luxendo service team. Modifications of 

system components have to be performed by the manufacturer or authorized and trained personnel. 

We ask the customer to keep a safety distance during service and maintenance and to wear laser protection 

glasses if necessary. If the Luxendo personnel should give any further safety instructions, these are to be obliged 

accordingly and immediately.  

During service, the room is classified as a laser safety class 3B area. 

 

8.2. Exchange of fuses and electric connections 

Only use original parts when changing fuses or replacing power cords. 

In case of a malfunction of the power supply the customer may change the built-in fuses. The two fuses are 

located in the fuse holders right above the kettle plug as shown in Figure 2. 
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Figure 2: Position of fuses 

The built-in fuses are type T 5 A/H, 250V, ø 5 mm x 20 mm cartridge fuses. 

To change the fuse, proceed as follows: 

• Unscrew protection cap (Figure 2, blue arrows) 

• Pull out protection cap and replace the old fuse with a new one 

• Reinsert and firmly screw in protection cap  

The customer may not alter the wiring of the system. In case the power cord detached, reconnect it to the AC 

network as described above. 

 

8.3. Maintenance by the customer 

 

The maintenance by the customer is limited to cleaning the housing, cleaning and disinfection of the sample 

chamber, the illumination and detection optics in it, and the sample carrier. 

 

a) To clean the housing proceed as follows: 
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• Shut down the microscope and unplug the power cord. 

• Make sure liquids do not enter the system. 

• Wipe the housing using a clean cloth wetted with water and a bit of detergent. Dry off using a 

lint-free cloth. 

For sterilization wipe the surfaces with a cloth wetted with 70% ethanol or 70% isopropanol. 

 

b) To clean the sample holder, proceed as follows: 

• Remove and disassemble the sample holder as described above. 

• Remove the FEP foil and residual glue. 

• For sterilization wipe the sample carrier and all parts of the sample holder (screws, mounting 

adapter) with 70% ethanol, then rinse them with distilled water. 

The sample carrier and mounting adapter may also be autoclaved. 

 

c) To clean the sample chamber, proceed as follows: 

• Shut down the microscope and unplug the power cord. 

• Make sure liquids do not enter the system. 

• Remove the sample holder as described above. 

• Remove remaining water from the water bath 

• Wipe the chamber using a lint-free cloth wetted with distilled water or 70% ethanol. 

• Pay special attention to avoid scratching the objective lenses during the cleaning process. 

 

d) To clean the objectives, proceed as follows: 

• Remove the sample holder as described above. 

• Clean the front lenses as commonly recommended using optics detergents and lens cleaning 

tissue. 

• Do not wipe the front lens of the objective with dry lens cleaning tissue to prevent scratching. 
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9. Dimensions 

 

Component Length (cm) Width (cm) Height (cm) Weight (kg) 

InVi SPIM 
main module 

72 43 41 75 

Power supply 30 30 14 12 

 

10. Environment 

 

The system must be installed in a closed room. 

Operation T = 22°C ± 5°C without interruption (24 h 
per day independent of system operation)  

Storage T = 15°C … 40°C 

Temperature gradient ± 0.5°C/h 

Relative humidity < 40% at 30°C 

Warm-up time 1-2 h 

Maximum elevation 2000 m 

 

11. Power supply configuration 

 

The Luxendo InVi SPIM uses an external power supply module. This module is connected to the AC network 

using the provided country-specific power supply cord. The PC and the camera(s) for detection are connected 

to the AC network using separate power supplies and cords. 

 

Voltage 
Frequency 

90 V AC … 240 V AC 
50 … 60 Hz 

Power consumption InVi SPIM Max. 200 W 
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Power consumption per camera Max. 70 W 

Power consumption PC Max. 600 W 

 

 

 

Figure 3: Wiring scheme of InVi SPIM system 

 

Power on the microscope by using the switch on the plugged power supply module. Initialization period is 

approx. two minutes; the system is then ready for usage and can be controlled via PC. 

 

To completely disconnect the system from the AC network, turn the power switch on the power supply to 

“OFF” and pull the plug out of the power socket. Access to this power socket must never be obstructed. 



  
   
       
 
 
 

 

 

 

  

   Page 71 of 74 

 

 

In case of an emergency, press the kill switch installed on the power supply’s front panel. This powers down 

the microscope immediately. 

To reset the kill switch, turn it counter-clockwise. 

12. Setting up the Luxendo InVi SPIM 

 

Installation and initial startup of the InVi SPIM has to be carried out by authorized Luxendo service personnel. 

Before working with the system for the first time, a training by a Luxendo representative is inevitably 

required. 

 

Do not set up the InVi SPIM close to a heat source, i.e. radiators or direct sunlight. An influence by air 

conditioning units is also possible and should be avoided. 

 

Do not set up the system in an explosion-hazardous area. 

 

 

Always use the provided power supply cord to connect the system to a properly installed safety socket. The 

protection by the protective ground contact must not be influenced by using an extension cord. 

 

The system contains components carrying hazardous voltage. It may only be opened by authorized Luxendo 

service personnel. The power cord has to be disconnected prior to opening the system. 

 

Maintenance and repairs, modification, exchange or removal of parts, the transport of the InVi SPIM module 

or any other encroachment on the system not described in this manual have to be executed by Luxendo or 

by personnel explicitly authorized by Luxendo. 
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This specifically applies to the microscope system, the built-in laser module, the lasers and cameras, the PC, 

power supplies, cable connections and other components of the system. 

 

The system contains a safety interlock that shuts off the lasers as soon as the sample chamber’s lid is opened. 

A notification will be displayed in the software user interface.  In order to make the lasers operational again, 

close the sample chamber’s lid and reset the lasers using the reset button next to the lid. 

After installation or modification, the InVi SPIM system has to be inspected thoroughly by Luxendo technical 

staff to ensure the system functions properly - particularly the mechanisms for protection from dangerous laser 

radiation. 

Optional components such as the temperature control unit should not be put on the same table as the InVi 

SPIM system itself to avoid vibrations. 

 

13. Warning labels 

 

Please pay special attention to the warning labels on the InVi SPIM system. Check if all labels listed below are 

clearly visible on your system and contact Luxendo if any of those are missing. You will receive a free 

substitute. 

 

Meaning of labels: 

 

Attention: 

Possible exposure to hazardous laser radiation when working with the system.  

 
Attention: 

Malfunctions and dangers that can occur during operation and can possibly lead to damages of the system 

or injury of the user. 
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Attention: 

Risk of electric shock. Possible exposure to hazardous voltage. 
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14. General information on handling laser components and illumination elements 

 

The InVi SPIM is a laser safety class 1 product. 

The lasers built into the system are encapsulated class 3B lasers. Exposure to hazardous laser radiation is 

prohibited by full housing and safety interlocks on all customer-accessible parts. 

 

Attention: By using control elements or performing adjustments or procedures not described in this manual, 

you risk exposure to hazardous laser radiation. 

 

When using the Luxendo InVi SPIM in compliance with the given instructions the user will not be exposed to 

hazardous laser radiation. Nevertheless, note the following warnings: 

• Under no circumstances are you permitted to remove any cover panels nor any parts that are not 

explicitly described in this manual. 

• Do not manipulate any safety interlock under any circumstances. Luxendo assumes no liability for 

damages caused by manipulations of the security mechanisms.  

 

Proper precautionary measures are mandatory, if health-damaging gases, dust and vapors, secondary 

radiation or explosive substances are produced due to laser radiation. 

 

 

 


